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General Information

xe "Document Tracking and Management System Overview"Document Tracking and Management System Overview
This application is a document entry and maintenance system that eliminates the requirement for the generation of paper documents, reduces the operational costs and requirements to physically transport documents between Admin and Disbursing sites, and increases production time.  It also helps reduce the occurrence of lost documents, and provides a centralized repository where documents can be stored and accessed instantaneously Marine Corps-wide.
The Disbursing Office (DO) level and Company (CO) level ELSIGs assigned by the DO or CO have access to this system.
See Also:
Document Tracking and Management System Help
About Document Tracking and Management System
Help

xe "Help"Document Tracking and Management System WebHelp
Document Tracking and Management System (DTMS) WebHelp consists of two basic types of help, Contents and Index, and Window Help.
Contents and Index consists of three search methods:
· Contents displays a treeview of books that you can open to find a WebHelp topic.
· Index displays an alphabetical list of topic names you can use to find a WebHelp topic. 
· Search displays a list of words found in WebHelp topics and enables you to find all of the WebHelp topics that contain a specific word.
Window Help allows you to view the WebHelp topic associated with the current web page.
How Do I Get Here?
1. Begin on any Document Tracking and Management System page.
2. From the Menu, choose Help.  A sub Menu displays.
3. Do one of the following:
· To view all WebHelp topics associated with the web pages, choose Contents and Index. The Contents and Index page displays.
· To view the WebHelp topic associated with the current web page, choose Window Help. The WebHelp topic displays.
See Also:
Help Format
Contents and Index
Contents
Index
WebHelp Search
Window Help
xe "Document Tracking and Management System WebHelp"

xe "Help:Help Format"Help Format
The standard format of the Document Tracking and Management System (DTMS) WebHelp facility consists of the following six areas:
· Topic Title
· Purpose
· How Do I Get Here?
· Procedures
· To Exit The Page
· See also
Topic Title
To assist you in accessing an appropriate WebHelp topic, Document Tracking and Management System pages have a corresponding help topic where the topic title matches the web page title.  Exceptions to this standard are message boxes and the Help Topics page for Document Tracking and Management System.
Topics without a one-to-one relationship to a Document Tracking and Management System page are titled to reflect the functionality or information they describe.
Purpose
Each topic contains a paragraph to inform you of the purpose of the Document Tracking and Management System page or functionality and identifies applicable ELSIG restrictions.  
How Do I Get Here?
Each topic contains the steps from the appropriate module frame to the Document Tracking and Management System page or function.  The steps assume you are logged on to Document Tracking and Management System unless indicated otherwise.
Procedures
Each topic lists the steps you take to input information, to initiate and complete processes, and access all functionality available to you on the Document Tracking and Management System page.  
Where a procedure consists of just one step, an arrow bullet precedes the step. For example:
To Accept the Choice
· Choose OK.
In an effort to accommodate mouse users and keyboard users, procedures are documented using general procedural terms such as ‘select’ and ‘choose’ and not mouse-specific terms such as ‘click,’ ‘double-click,’ and ‘point to’.
To Exit the Page
To exit the page
· Choose the X in the upper right-hand corner of the page.
See also
See also is a list of help topics related to the current topic which are not specifically identified in the current topic.
See also:
Document Tracking and Management System Help
xe "Contents and Index"

xe "Document Tracking and Management System WebHelp"

xe "Help"

xe "Help:Contents and Index:Contents"

xe "Help:Contents and Index:Search"Contents and Index
This topic allows you to open the entire WebHelp facility, and automatically displays three views: Contents, Index and Search, with the Contents view open.
· The Contents function displays a Table of Contents treeview of the WebHelp topics in the Document Tracking and Management System and allows you to view those pages. 
· The Index function allows you to locate pages associated with keywords. 
· The Search function allows you to locate all WebHelp topics that contain a specific word.
How Do I Get Here?
1. Begin on any Document Tracking and Management System page.
2. From the Help menu, choose Contents and Index.  The Contents and Index topic displays.
To Utilize Contents and Index
· Do one of the following:
· To view a list of all WebHelp topics, choose Contents. The Contents topic displays.
· To locate a WebHelp topic containing a specific word, choose Index. The Index topic displays.
· To locate all WebHelp topics containing a specific word, choose Search.  The Search topic displays.
See Also:
Document Tracking and Management System Help
xe "Contents"

xe "Document Tracking and Management System WebHelp"

xe "Help:Contents and Index"Contents
This topic allows you to see a list of all WebHelp topics.
How Do I Get Here?
1. Begin on the Contents and Index topic.
2. Choose Contents. The Contents topic displays.
To Utilize the Contents Tab
1. From the Contents list, choose the Book you want view. The Treeview expands.
2. From the Treeview, choose the WebHelp topic you want to view. The WebHelp topic displays.
See Also:
Document Tracking and Management System WebHelp
xe "Help:Contents and Index"

xe "Help:Contents and Index:Index"

xe "Index"Index
This topic allows you to locate all WebHelp topics that contain a specific word.
How Do I Get Here?
1. Begin on the Contents and Index topic.
2. Choose Index. The Index topic displays.
To Utilize the Index
1. From the Letter list, choose the letter for the topic you want to find. The applicable WebHelp topic names display.
2. From the list of WebHelp topic names, choose the desired topic.
See Also:
Document Tracking and Management System Help
xe "Help:Contents and Index"WebHelp Search
This topic allows you to search for all WebHelp topics that contain a specific word.
How Do I Get Here?
1. Begin on the Contents and Index topic.
2. Choose Search. The Search topic displays.
To Utilize the Search Tab
1. From the Letter list, choose the desired letter. The applicable word displays with a string of numbers that tell you how many topics the word is in.
2. From the Number list, choose the desired number and the associated topic displays.
See Also:
Document Tracking and Management System Help
xe "Document Tracking and Management System WebHelp"

xe "Help"

xe "Help:Window Help"

xe "Window Help"Window Help
This function allows you to display the WebHelp topic associated with the current web page.
How Do I Get Here?
1. Begin on any Document Tracking and Management System page.
2. From the Help menu, choose Window Help.  The WebHelp topic associated with the current web page displays.
See Also:
Document Tracking and Management System Help
xe "Document Tracking and Management System WebHelp"

xe "Help:Print WebHelp Topic"Print WebHelp Topic
This function allows you to print the information in a Webhelp topic.
How Do I Get Here?
1. Begin on any Document Tracking and Management System (DTMS) WebHelp page.
2. Left click on the WebHelp topic to select it.
3. Right click. A menu displays.
4. From the menu, choose Print. The WebHelp topic prints.
xe "Before You Begin"Before You Begin
You must use the same ELSIGs you use on UD/MIPS or RAPTRS. They must be uploaded onto the Document Tracking and Management System database. 
See Also:
About Document Tracking and Management System
xe "Hardware and Software Requirement"Hardware and Software Requirements
The following identifies the system hardware requirements and additional software that supports Document Tracking and Management System.
Computer Hardware Requirements per Marine Corps Standards:
Mouse: Required
Video: VGA, 800x600 minimum resolution recommended
Operating System: Windows NT 4.0/2000
Software Included:
Internet Explorer 6.0 
See Also:
About Document Tracking and Management System
xe "About Document Tracking and Management System"

xe "About DTMS"About Document Tracking and Management System
The Document Tracking and Management System (DTMS) web-based application provides you with:
· The ability to retrieve information from the Operational Data Store Enterprise (ODSE) database.  
· Logging and tracking mechanisms that maintain the historical events of each document.
· A real-time display of a document's position and status.
· An automated means for the disbursing office to initiate pay action or research by the administration office.
· An electronic connection to all related documents and comments. 
This system:
· Accommodates any electronic document stored by the document application.
· Stores comments attached to an electronic document without modifying the original document.
· Restricts access to electronic documents based on the Electronic Signature (ELSIG) supplied by the user.
· Provides displays by which you can access documents assigned to you or any workgroup defined for your unit.
See Also:
Before You Begin
Document Tracking and Management System Login
Document Tracking and Management System Logout
Document Tracking and Management System Overview
Hardware and Software Requirements
Main Page
Technical Assistance
Troubleshooting
Users
xe "Document Tracking and Management System Login"

xe "DTMS Login"Document Tracking and Management System Login
This page controls access to Document Tracking and Management System (DTMS) and ensures the integrity of DTMS data.
How Do I Get Here?
1. Begin on any DTMS page.
2. From the File menu, choose Login. The ELSIG Login page displays.
To Login to DTMS
1. In the Unit box, type or choose your five character DSSN or RUC.
2. In the ELSIG box, type your 7-character ELSIG.
3. In the Seed box, type your 3-character Seed.
4. Choose Login.  The User Console page displays in the version determined by the login ELSIG.
See Also:
Admin and Disbursing ELSIGs
Document Tracking and Management System Logout
xe "Document Tracking and Management System Logout"

xe "DTMS Logout"Document Tracking and Management System Logout
This function saves any record processed by the Admin Preparer to the database and then logs you off of the ELSIG system and returns you to the Main page.
How Do I Get Here?
· Begin on any DTMS page.
To Logout of DTMS
· From the File menu, choose Logout.  You return to the Main page.
See Also:
Document Tracking and Management System Login
xe "Main Menu"

xe "Main Page"Main Page
This page is the only access into the web application and supplements what is in the Microsoft Internet Explorer browser menu. Depending on the login ELSIG and where you are in the system, the following menu items may be available:
File menu:
· Login - Allows you to log on to Document Tracking and Management System (DTMS).
· Logout - Allows you to log out of Document Tracking and Management System.
· New Document  
· NAVMC 11060 - Allows you to create a Separation/Travel Pay Certificate.
· NAVMC 11116 - Allows you to create an Miscellaneous Military Pay Order/Special Payment Authorization document.
· Advisory Notice - Allows you to create an Advisory Notice and attach it to a document.
Tools menu:
· Preferences
· User Defaults - Allows you to change the section default value to reflect the section in which you perform the majority of your tasks.
· Section Maintenance - Allows you to add or delete a section on the database or a member's record from the database.
· ELSIG Upload - Allows you to import an ELSIG file to the database.
· SSN Search - Allows you to view or process the record for a specific SSN you entered.
· Document Assignment - Allows you to assign the document to a specific staff member, to a specific section, or to unassign it.
Reports menu:
· 5-Day EAS - Allows you to view or print a listing of separation documents that are within five days or less of the Expiration of Current Contract date on the form, excluding appellate leave documents.
· 10-Day Quad - Allows you to view or print a listing of all electronic Quad6 documents that are still in an open status ten days after their initial certification.
· 10-Day Separation - Allows you to view or print a listing of all electronic separation documents in an open status that were originally certified with less than ten days prior to the Expiration of Current Contract date on the for, excluding appellate leave documents.
· Appellate Leave - Allows you to view or print a listing of Appellate Leave Separation documents that are in an open status. 
· Missing NAVMC 11060 - Allows you to view or print a listing of individuals who separated from the Marine Corps without a NAVMC 11060 being submitted on them.
· Pending TTCs - Allows you to view or print a listing of all open documents that have TTC and sequences entered in the diary transaction area that are missing diary numbers and dates.
· RFL Management - Allows you to view or print a listing of disbursing symbols that have documents that fall into a date range, along with the averaged work times for each document type as well as averages for the Marine Corps as a whole.
· Unit Statistics - Allows you to view or print a listing of activity on documents submitted to their Disbursing Unit, the current status for those documents, and the date they were closed.
Help menu:
· Contents and Index - Allows you to view all Help topics associated with all Web pages and to find Help topics that contain a specific word.
· Window Help - Allows you to view the Help topic associated with the Web page you are on.
xe "Technical Assistance Contacts"Technical Assistance Contacts
Contact:
· MISSO - Administrators
· Finance or Disbursing - RFL Systems Chief Officer
Printed_Manual

Print the Manual
This function enables you to view and download the document if you want to print the entire DTMS WebHelp Manual.
To View the Help Manual
1. To display the complete manual for viewing, click the left mouse button on this View Full Help Manual link.  The Table of Contents displays.  
2. To view a desired topic, from the Table of Contents, choose the topic page number.  The desired topic displays. 
3. To return to this topic, from the Contents treeview, choose Print the Manual.  The topic displays.
To Download the Help Manual
1. To download the manual, click the right mouse button on this View Full Help Manual link.  A menu displays.
2. From the menu, choose the Save Target As option.
3. Choose the location you want to save the document to. 
4. Choose Save. The document is saved to that location.
ELSIGs

xe "Admin and Disbursing ELSIGs"Admin and Disbursing ELSIGs
ELSIGs (Electronic signatures) govern the Admin and Disbursing Office's actions in processing transactions on member's records.
The Electronic Signature (ELSIG) module allows assigned users a unique authorization level. The disbursing officer (DO), commanding officer (CO), or ELSIG Control Officer (ECO) assigns ELSIGs to users who perform duties corresponding to the ELSIG authority level. The authorization level determines what functions in a Document Tracking and Management System application are available to the user. 
See Also:
Admin Certifier
Admin Preparer
Admin Reviewer
Disbursing Auditor
Disbursing Certifier
Disbursing Preparer
ELSIG Upload
xe "ELSIG Update"ELSIG Update
Document Tracking and Management System does not allow you to update ELSIGs.  You must update the ELSIGs on UD/MIPS or RAPTRS, as is applicable, and then upload the ELSIGs to Document Tracking and Management System.
See Also:
Admin and Disbursing ELSIGs
ELSIG Upload
xe "ELSIG Upload"ELSIG Upload
This function allows you to upload an ELSIG file to Document Tracking and Management System.  If your ELSIG is expired, you must submit an updated ELSIG file that has been exported from UD/MIPS or RAPTRS.
How Do I Get Here?
1. Begin on the any Document Tracking and Management System page.
2. From the Tools menu, choose ELSIG Upload.  The ELSIG Upload page displays.
To Upload a File
1. In the Unit box, type the Unit Number or the DSSN.
2. In the ELSIG box, type the ELSIG.
3. In the Seed box, type the Seed.
4. If you are logged in as an Admin or Disbursing certifier, do one of the following:
· If you want to overwrite ELSIGs currently on the system, check Overwrite Existing ELSIGs.
· If you do not want to overwrite the existing ELSIGs, clear Overwrite Existing ELSIGs.
5. Do one of the following:
· If you know the path of the file you want to upload, in the Select the ELSIG file you wish to upload box, type the Path of the file you want to upload.
· If you do not know the path of the file you want to upload, choose Browse, and then in the Select the ELSIG file you wish to upload box, choose the File you want to upload.
6. Choose Upload & Login. The file is uploaded to the Document Tracking and Management System database, and you return to the previous page.
See Also:
Admin and Disbursing ELSIGs
xe "Users"Users
The Users for this application will be Admin and Disbursing personnel with Admin Preparer, Admin Reviewer, Admin Certifier, Disbursing Preparer, Disbursing Auditor, and Disbursing Certifier-level Authority ELSIGs.
See Also:
Admin and Disbursing ELSIGs
xe "Commanding Officer"Commanding Officer
This function has the same ELSIG Authority as the Admin or Disbursing Certifier ELSIG Authority, for the unit it serves.
See Also:
Admin Certifier
Disbursing Certifier
xe "Disbursing Officer"Disbursing Officer
This function has the same ELSIG Authority as the Admin or Disbursing Certifier ELSIG Authority, for the unit it serves.
See Also:
Admin Certifier
Disbursing Certifier
xe "ELSIG Control Officer"ELSIG Control Officer
This function has the same ELSIG Authority as the Admin Certifier or Disbursing Certifier ELSIG Authority for the unit it serves.
See Also:
Admin Certifier
Disbursing Certifier
xe "Admin Preparer"Admin Preparer
The Admin Preparer can view electronic documents and run reports on all documents created for their RUC.
Access Rights:
· Prepare a NAVMC 11116 (quad) or NAVMC 11060 document.
· Copy an existing NAVMC 11116 and change the SSN to make another document.
· Edit any document excluding any transactions entered in the diary block by the disbursing unit.
· Assign a document currently assigned to you, to another user or work group.
· Delete any document that you created which has not previously been certified.
· Self-assign any document that is currently sitting in the work pool.
· Forward for review, any document that has been assigned to you.
· Add your ID to a defined workgroup if that workgroup allows self-assignment. 
See Also:
Admin and Disbursing ELSIGs
xe "Admin Reviewer"Admin Reviewer
The Admin Reviewer can review electronic documents for all preparers within the RUC and run reports on all documents for their RUC.
Access Rights:
· Review any document.
· Assign any document to a user or workgroup.
· Delete any document that has not previously been certified.
· Kill any document that has previously been certified.
· Self-assign any document.
· Forward to the Certifier any document that you reviewed. 
· Delete TTC's.
See Also:
Admin and Disbursing ELSIGs
xe "Admin Certifier"Admin Certifier
The Admin Certifier can certify electronic documents and run reports on all documents generated by their RUC.
Access Rights:
· Prepare a NAVMC 11116 or NAVMC 11060 document. Since the certifier cannot generate transactions, they cannot enter any data into the diary block. This requires a preparer action.
· Edit any document. This excludes any transactions entered in the diary block by the disbursing unit.
· Assign a document currently assigned to them to another user or workgroup.
· Close any advisory notice sent to a unit from the disbursing office as a document re-certified, killed, or closed.
· Delete any document that you created which has not previously been certified.
· Self-assign any document currently sitting in the work group.
· Review any document.
· Kill any previously certified document.
· Certify a reviewed document.
See Also:
Admin and Disbursing ELSIGs
xe "Disbursing Preparer"Disbursing Preparer
The Disbursing Preparer can create electronic documents, Zero Balance Separations DTLs, work electronic documents from Admin units and forward any document for review.
Access Rights:
· Review any document.
· Input disbursing transactions into the diary block.
· Edit any disbursing transactions in the diary block.
· Assign a document currently assigned to you to another user or workgroup.
· Self-assign any document.
· Forward for review any document.
· Create an advisory notice to be forwarded for review.
See Also:
Admin and Disbursing ELSIGs
xe "Disbursing Auditor"Disbursing Auditor
The Disbursing Auditor can audit electronic documents from Admin units and view or print quads by DSSN or RUC.
Access Rights:
· Review any document.
· Assign any document to a user or workgroup.
· Self-assign any document.
· Forward to the certifier, any document that you have reviewed.
· Create an advisory notice to be forwarded to the Certifier.
· Delete any advisory notice that has not previously been certified.
· Kill any advisory notice that has previously been certified.
See Also:
Admin and Disbursing ELSIGs
xe "Disbursing Certifier"Disbursing Certifier
The Disbursing Certifier can certify electronic documents from Admin units and view and print documents created by their DSSN or RUC.
Access Rights:
· Review any document.
· Assign any document to a user or workgroup.
· Kill any document that has previously been certified.
· Self-assign any document.
· Close any document that you have reviewed.
· Create an advisory notice to be certified and sent to a specific Admin unit.
· Delete any advisory notice that has not previously been certified.
· Close or kill any advisory notice that has previously been certified.
· Forward the NAVMC 11060 for zero balancing.
See Also:
Admin and Disbursing ELSIGs
Documents

xe "Document:User Console"

xe "User Console"User Console
This page allows you to display all documents currently assigned to the login ELSIG and all unassigned documents within any workgroup to which the login ELSIG belongs that need to be certified. 
The data displayed on this page is retrieved from the Document Status History table and is determined by the login ELSIG. This page allows you to view ten rows at a time and each row displays brief information about a member's record. The records are listed oldest to newest, and the first byte of the SSN on the record is always zero. 
The Preparer can view only documents that the Preparer created that have not been sent to the Certifier. The Certifier can view only documents assigned to the Certifier for certification.
How Do I Get Here?
1. Begin on the ELSIG login page.
2. Follow the steps in the Document Tracking and Management System Login topic, in the To Login to Document Tracking and Management System section. The User Console page displays.
OR
· On any DTMS page, from the menu, choose DTMS Home.
This page displays the following information:
Header
· User Name (First Name, MI, Last Name)
· RUC NNNNN
· Title (User Console)
Body 
· Date Document Created (YYYY/MM/DD)
· Member SSN (####-##-###)
· Member Name (Last Name, First Name, MI)
Navigation
· Top
· Previous
· Next
· Bottom
Section Assignments
· Section Assigned To:
· Date Document Created (YYYY/MM/DD)
· Member SSN (####-##-###)
· Member Name (First Name, Last Name, MI)
· Document Type
· Document Status
To View the Document
· Choose the Member Name on the desired record. The Document page displays.
Note:If the document is an Advisory Notice, then zeroes display under SSN and Advisory Notice displays under Member Name.
To View the Document History
· Choose View History on the desired record. The Document History page displays.
To Print a Document Page
· On the record you want to print, choose Print Document. The Document page displays.
To Change Your Location on The Web Page:
1. To move to the First ten Rows, choose Top.  Your cursor moves to the first record of the first ten rows on the list.
2. To move to the Previous ten records, choose Previous. Your cursor moves to the first record of the previous ten records.
3. To move to the Next ten records, choose Next.  Your cursor moves to the first record of the next ten records on the list.
4. To move to the Last ten records, choose Bottom.  Your cursor moves to the first record of the last ten records on the list.
5. To view the Updated Version of this web page without leaving the page, from the browser, choose Refresh.  The updated version of this web page displays.
See Also:
Create Document
Document Status
Document Tracking and Management System Logout
xe "Document:Document Flow"

xe "Document Flow"Document Flow
If the document is created by or assigned to the Admin Preparer:
It displays on the Admin Preparer's user console and can be:
· Edited and forwarded for review.
· Deleted if not previously certified.
If the document is forwarded for review:
It displays on the Admin Reviewer's and Admin Certifier's user console and can be:
· Deleted if not previously certified.
· Killed if previously certified.
· Returned to the Admin Preparer for additional work.
· Released to the Certifier by the Admin Reviewer.
· Certified by the Admin Certifier and forwarded to Disbursing. 
Note: If the document was previously returned from Disbursing with a discrepancy notice, the Admin Certifier must update the notice status with a comment.
If the Document is released to the Certifier:
It displays on the Admin Certifier's user console and can be:
· Deleted if not previously certified.
· Killed if previously certified.
· Returned to the Admin Preparer for additional work.
· Certified by the Admin Certifier and forwarded to Disbursing.  If the document was previously returned from disbursing with a discrepancy notice, the Admin Certifier must update the notice status with a comment.
Note: A document certified by Admin is automatically forwarded to Disbursing.
If the Document is forwarded to Disbursing:
It displays on the work-pool user console and can be:
· Assigned to the Disbursing Preparer by the Disbursing Auditor or Disbursing Certifier who is assigning the document to the Disbursing Preparer.
· Assigned to the Disbursing Preparer by the Disbursing Preparer assuming responsibility of the document.
· Forwarded with the discrepancy noted by the Disbursing Auditor to the Disbursing Certifier.
· With the discrepancy notice attached, returned by the Disbursing Certifier to Admin.
If the Document is assigned to the Disbursing Preparer:
It displays on the Disbursing Preparer user console and can be:
· Worked and forwarded for review.  The comment should indicate whether a discrepancy is noted.
If the Document is forwarded for review:
It displays on the Disbursing Auditor and Disbursing Certifier user consoles and can be:
· Returned to the Disbursing Preparer for additional work.
· Forwarded by the Disbursing Auditor to the Disbursing Certifier for 11116 documents. A comment should indicate whether a discrepancy is noted.
· With a discrepancy notice attached, returned by the Disbursing Certifier to Admin.
· Certified by the Disbursing Certifier.
· Forward for zero-balance (11060)
If the Document is forwarded to the Disbursing Certifier:
It displays on the Disbursing Certifier's user console and can be:
· Returned to the Disbursing Preparer for additional work.
· Returned to Admin with a discrepancy notice attached.
· Certified by the Disbursing Certifier.
If the Document is returned to Admin:
It displays on the work-pool user console and can be:
· Assigned to the Admin Preparer by the Admin Reviewer or Admin Certifier who is assigning the document to the Admin Preparer.
· Assigned to the Admin Preparer by the Admin Preparer that assumes responsibility of the document.
· Forwarded with a response by the Admin Reviewer to the Admin Certifier.
· Killed by the Admin Certifier for the unit that generated the document.
· Closed by the Admin Certifier for the disbursing unit.
· Updated in the instruction section, re-certified, and forwarded to Disbursing by the Admin Certifier.
See Also:
Create Document
Document Status
xe "Document:Document Status"

xe "Document Status"Document Status
This function allows you to see where the document is in the work process.
To View a Document Status
· To view the status of the 11060 or 11116 document, in the User Console page, see the "status" field.
xe "Missing Documents"Missing Documents
If a member's document is certified with a DSSN that is different from the DSSN of the Admin unit it is being submitted to, the document will be placed in a 'missing' status. To prevent this, before forwarding the document, the certifier must change the DSSN to reflect the receiving unit's DSSN.
xe "Document:Document Assignment"Document Assignment
This page allows you to assign an electronic document to a specific user or previously defined workgroup and allows you to sort the documents by different categories.
How Do I Get Here?
1. Begin on any Document Tracking and Management System page.
2. From the Tools menu, select Document Assignment. The Document Assignment page displays.
This page consists of the following information:
Header
· User Name, of RUC
· Title - Document Assignment
Body
· Last Certified Date (This is the last time the originating unit forwarded the document to the receiving unit)
· Document Created Date
· SSN
· Member Name
· Assign(ed) To
To Assign Documents
1. In the Sort by box, select the field you want the documents to be sorted by. The default is Current Preparer.
2. In the Ascending checkbox, do one of the following:
· To sort the documents in ascending order, select the checkbox.
· To sort the documents in descending order, clear the checkbox.
3. In the Assign(ed) To box, do one of the following:
· To assign the document to another person or section, select the name or section.
· To unassign a document, select Unassign Document.
4. Choose Apply Changes. The documents are sorted in the applicable order.
See Also:
Create Document
xe "Document:assignment"

xe "Document:Document Self Assignment"

xe "Document Assignment"Document Self Assignment
This page allows you to assign an electronic document to a specific user or previously defined workgroup.
How Do I Get Here?
1. Begin on the User Console page.
To Self Assign a Document
1. From the work pool list, choose a Member Name. A message prompts you to choose whether you want to assign the document to yourself.
2. Do one of the following:
· To assign the document to yourself, choose OK. The document is assigned to you and is visible on your user console.
· To leave the document unassigned, choose Cancel. The document stays in the workpool, unassigned.
3. You return to the User Console page.
See Also:
Create Document
xe "Input SSN"Input SSN
This page allows you to input a Social Security Number to search for documents submitted for that one SSN. If the member's record is not available, a message informs you the member was not found, and to continue, you must type another SSN. If the SSN does not exist on the database, the SSN Search page displays with no information.
How Do I Get Here?
1. Begin on the User Console page.
2. From the Tools menu, choose SSN Search. The Input SSN page displays.
How To Input an SSN
1. In the Service Code and SSN box, the member's one-digit Service Code is automatically populated. Type the member's nine-digit Social Security Number.
2. Choose Search. The SSN Search page displays.
xe "SSN Search"SSN Search
This function allows you view documents related to a specific SSN, and it's history. The document page can also be printed.
The buttons at the bottom of the page allow the user to move through the document list.
How Do I Get Here?
1. Begin on the Input SSN page.
2. In the Service Code and SSN box, the member's one-digit Service Code is automatically populated. Type the member's nine-digit Social Security Number.
3. Choose Search. The SSN Search page displays. If the SSN is not on the database, the page displays with no information. To continue, from the Tools menu, choose SSN Search. 
The following information displays:
Header
· User Name, of RUC or DSSN
· Title (SSN Search)
Body
· Documents For
· Member Name
· Member SSN
· Document Created Date
· Document Type
· Document Status 
· View History
· Print Document
At the Bottom
· Top
· Previous
· Next
· Bottom
To View the Document
· Choose the Member Name on the desired record. The Document page displays.
To View the Document History
· Choose View History on the desired record. The Document History page displays.
To Print a Document Page
· Choose Print Document on the desired record. The Browser Print window displays.
See Also:
Create Document
NAVMC 11060: Separation/Travel Pay Certificate
NAVMC 11116: Miscellaneous Military Pay Order/Special Payment Authorization
xe "Advisory Notice"

xe "Delete TTCs"

xe "Document:NAVMC 11116: Miscellaneous Military Pay Order/Special Payment Authorization"

xe "forms"

xe "Miscellaneous Pay Voucher"

xe "NAVMC 11116"

xe "NAVMC:11116"

xe "Quad1-6"NAVMC 11116: Miscellaneous Military Pay Order and Special Payment Authorization
This page allows an administrative office or a disbursing office to view the Miscellaneous Military Pay Order and Special Payment Authorization (NAVMC 11116) authorizing payment to a member. Only the selected options display.
When the document is viewed by the disbursing office, if another action is found to be necessary, an advisory notice may be attached to the document and the document returned to the Admin office. 
How Do I Get Here?
1. Begin on the User Console page.
2. From the Listing, choose the member's Name of the 11116 record you want to view. The document page displays.
This page consists of the following information:
Header
· SSN
· Admin RUC
· DSSN
· Name
· Reporting Unit Code
· Expiration of Current Contract
Payments
· Special Payment
Adjustments
· Advance Pay
· Pay Months
· Repayment Months
· Authorization
· Advance Housing Allowances
· Pay Months
· Repaid Months
· Authorization
· Estimated Move-In Date
· Currency Type
· Rent Amount
· Security Deposit
· Additional Moving Expenses
· Instructions/Other
Diary Transaction Information
· Transaction Document Id Number
· Diary Generated Date (YYYY/MM/DD)
· TTC number
· TTC SEQ number
· Description
· Add Transaction
· Delete TTC Transaction
Other Options
· Depending on the status of the document, and on the login ELSIG, choose the desired option.
· Add Document
· Add Document Comment
· Attachments
· Close Document
· Delete Document
· Duplicate Document
· Forward for Audit
· Forward for Zero Balance Audit
· Forward to Reviewer
· Forward to Certifier
· Kill Document
· Return to Admin
· Return to Preparer
· Update Document
· Update/Forward to Disbursing
· Update/Forward for Review
· View Attached Files
See Also:
Advisory Notice
Create Document
Update Document
xe "Advisory Notice"

xe "Delete TTCs"

xe "Document:NAVMC 11060: Separation/Travel Pay Certificate"

xe "forms"

xe "NAVMC 11060"

xe "Separation/Travel Pay Certificate"NAVMC 11060: Separation and Travel Pay Certificate
This page allows an administrative office or a disbursing office to view the Separation and Travel Pay Certificate which authorizes payment to a member. Only the selected options display.
When the document is viewed by the disbursing office, if another action is found to be necessary, an advisory notice may be attached to the document and the document returned to the Admin office. 
How Do I Get Here?
1. Begin on the User Console page.
2. From the Listing, choose the member's Name of the 11060 record you want to view. The document page displays.
This page consists of the following information:
Header
· Title (Separation/Travel Pay Certificate)
The next four fields display only if there is a correction to the document:
· Attached Correction (s):
· Document type
· Date Created (all date/timestamps will be based on the current time of the DTMS Server)
· Time Created
· SSN
· Admin RUC
· DSSN
· Name (Last Name, First Name, MI)
· Reporting Unit Code
· Expiration of Current Contract
· Unit Address
· Effective Date of Separation from Active Duty
· Program Designator
· Reason
· Type of Discharge
· Home of Record
· Place From Ordered to Active Duty
Pay Information
· Recoup Enlistment Bonus/Recoup Re-enlistment Bonus
· Authorization
· Lump Sum Leave
· Number of Days
· Previous LSL Used
· Authorization
· Leave Computation
· Balance
· As Of Date
· Unreported Leave
· Computed Leave Balance
· Leave Awaiting Separation
· Number of Days
· Permissive TAD Days
· Departure Date
· Authorization
· Pay Separation Pay
· Active Service Years and Months
· Authorization
· Pay Disability Severance Pay
· Active Service Years and Months
· Authorization
· Loan Recoup
· Type of Loan
· Loan Info
· Other
· Description
· Accounting/Appropriation Data--Accounting Clarification for Separation without Orders
· Appropriation Symbol and Subhead
· Object Class
· Bureau Control Number
· Sub Allotment
· Authorization Accounting Activity
· Transaction Type
· Property Accounting Activity
· Cost Code(s)
PART II - Marine Section
· Appellate Leave
· As of Date
· Voluntarily on Leave for number of Days
· Involuntarily on Leave for number of Days
· Previous Lump Sum Leave used 
· I Elect Payment Of number of days Lump-Sum Leave
· I elect to be issued Government Transportation Request (s) for travel and my expenses
· From Location
· To Location
· I elect to be paid advance separation travel allowances for myself and my dependents
· From Location
· To Location
· By Mode of Transportation
· Submit Claim To Address
· Permanent Mailing Address
· E-mail Address
· Contact Phone Number
Diary Transaction Information
· Transaction Document Id Number
· Diary Generated Date (YYYY/MM/DD)
· TTC number
· TTC SEQ number
· Reported Description
· Add Transaction
· Delete TTC Transaction
Other Options
· Depending on the status of the document, and on the login ELSIG, choose the desired option.
· Add Document
· Add Document Comment
· Attach Correction
· Attachments
· Close Document
· Delete Document
· Duplicate Document
· Forward for Audit
· Forward for Zero Balance Audit
· Forward to Reviewer
· Forward to Certifier
· Kill Document
· Return to Admin
· Return to Preparer
· Update Document
· Update/Forward to Disbursing
· Update/Forward to NAMALA
· Update/Forward for Review
· View Attached Files
See Also:
Advisory Notice
Create Document
Update Document
xe "Create Document"

xe "Document:Create Document"Create Document
This page allows the Admin Preparer and Disbursing Preparer ELSIGs to create a new document and to link it to any electronic document assigned to them, or to any group that they are a member of, to complete actions for this form. For forms that show date/time, all date/timestamps will be based on the current time of the DTMS Server.
How Do I Get Here?
1. Begin on the any Document Tracking and Management System page.
2. From the File menu, select New Document and then do one of the following:
· To create a Miscellaneous Military Pay Order or Special Payment Authorization, choose NAVMC 11116.
· To create a Separation or Travel Pay Certificate, choose NAVMC 11060. Only one separation or travel pay document per member should be created within a 30 day period. If you attempt to create a second document, the History document displays any existing NAVMC 11060 document.
3. The Input SSN page displays.
To Create A Specific Document
1. In the SSN box, type the Service Code and the SSN of the member for which you want to create a new document.
2. Choose Create. The applicable Document page displays, or a message informs you the SSN was invalid. If the SSN is invalid, you must begin again from How Do I Get Here? previously mentioned on this page.
See Also:
Close Document
Create 11060 Document
Create 11116 Document
Delete Document
Document Self Assignment
Document Flow
Kill Document
Route Document
xe "Create 11116 Document"

xe "Delete TTCs"

xe "Document:Create 11116 Document"

xe "Quad1-6"Create 11116 Document
This page allows an administrative office to create the Miscellaneous Military Pay Order and Special Payment Authorization (NAVMC 11116) document for a member.
This page allows the Admin Office to link to any electronic document assigned to it or any group that it is a member of. The Admin Office can add the document to the Document Tracking and Management System database, add a comment to the document, and add and forward the document for review. Supporting documents necessary to conclude actions for this form are attached by links and are stored on the Document Tracking and Management System database. Depending on the login ELSIG, a document options menu displays to enable you to continue the document processing.
To Create a NAVMC 11116:
The fields in the Header section are automatically populated from the ODSE database. In the Payments and Adjustments sections, only when a payment type selection is made are the fields applicable to that payment type available for input by the user.
Header
1. SSN is used as the key for deriving information from the ODSE database.
2. Admin RUC is not editable.
3. DSSN is only editable by Admin Reviewer ELSIGs or Certifier ELSIGs.
4. Name is not editable.
5. Reporting Unit Code is editable.
6. Expiration of Current Contract is editable. If the member does not have an ECC on the ODSE database, the field contains yyyy/mm/dd to prompt the user to input the date.
Payments
· If applicable, check the Special Payment box.
Adjustments
1. If applicable, check the Advance Pay box.
2. From the Pay list, select the Number of months the advance pay is incident to PCS orders. Valid values are one to three, and the default value is one.
3. From the Repayment list, select the Number of months in which the advance pay is to be repaid. Valid values are one to twenty-four, and the default value is twelve.
4. In the Authorization box, type in free form text, the Information to justify the payment or adjustment, up to 50 characters.
5. If applicable, check the Advance Housing Allowances box.
6. From the Pay list, select the Number of months of advance pay to be paid. Valid values are one to three, and the default value is three.
7. From the Repaid list, select the Number of months in which the Advance Housing Allowance pay is to be repaid. Valid values are one to twelve, and the default value is 12.
8. In the Authorization box, type in free form text, the Information to justify the payment or adjustment, up to 50 characters.
9. In the Estimated Move-In Date box, type the date estimated to move in.
10. In the Currency Type list, select the Currency Type that is used to pay the housing allowance as indicated in the lease. US Dollar is the default value.
11. In the Rent Amount box, type the Monthly Rent Amount in 99999999.99 format up to ten digits.
12. In the Security Deposit box, type the Amount of the security deposit in 99999999.99 format, up to ten digits.
13. In the Additional Moving Expenses box, type the Amount of additional moving expenses, in 99999999.99 format, up to ten digits.
14. In the Instructions/Other box, with up to 3800 characters, type Information or Instructions to enhance or clarify information provided on this form, or to add relevant information that falls outside of the realm of the categories on this form.
Diary Transaction Information
If anything is entered in this section, the Number field and the Date field are required to be entered by the Admin Preparer. It is not required by the Disbursing Preparer but must be entered for the document to be certified.
1. In the Number box, type the five-digit diary Transaction Document ID number.
2. In the Date box, type the Diary Generated Date in YYYY/MM/DD format. 
3. In the TTC box, type the three-digit TTC number.
4. In the SEQ box, type the three-digit TTC SEQ number.
5. In the Reported box, type the Description of the transaction up to 350 characters.
6. Choose Add Transaction. The Transaction is updated and displays beneath Add Transaction. A selected check box displays to the left of the transaction.
7. If you want to Delete a TTC Transaction, check the applicable Check Box. The transaction no longer displays when the document is updated.
Other Options
1. Do one of the following:
· To Add a document, choose Add Document. The document is added to the database.
· To Add a Document Comment, choose Document Comment. The comment is attached to the current document.
· To Add or Forward a document for review, choose Add/Forward for Review. The document is added to the database and forwarded to the appropriate section.
2. You return to the User Console page.
See Also:
Create Document
xe "Create 11060 Document"

xe "Delete TTCs"

xe "Document:Create 11060 Document"Create 11060 Document
This page allows the Admin Preparer level Authority ELSIGs and the Admin Certifier level Authority ELSIGs to create the new Separation and Travel Pay Certificate (NAVMC 11060) document.
This page allows the Admin Office to link to any electronic document assigned to it or any group that it is a member of. The Admin Office can add the document to the Document Tracking and Management System database, add a comment to the document, and add and forward the document for review. Supporting documents necessary to conclude actions for this form are attached by links and are stored on the Document Tracking and Management System database. Depending on the login ELSIG, a document options menu displays to enable you to continue the document processing.
Only one document is allowed to be created on any one member in a 30 day period.
To Create a NAVMC 11060:
The fields in the Header section are automatically populated from the ODSE database. In the Pay Information and Part II - Marine sections only when a payment type selection is made are the fields applicable to that payment type available for input by the user.
Header
1. The SSN is used as the key for deriving information from the ODSE database and is not editable.
2. The Admin Reporting Unit Code is based on the member's RUC.
3. The DSSN is not editable.
4. The Name is not editable.
5. The Reporting Unit Code is used to drive the unit block information.
6. The Expiration of Current Contract is editable.
7. The Unit Address is automatically populated based on the member's RUC.
8. The Effective Date of Separation from Active Duty is automatically populated in YYYY/MM/DD format and is not required for appellate leave separations.
9. In the Program Designator list, select the Code that describes the type of separation the member is taking, choose OK. You return to the 11060 document. The default value is MBK1-SEPARATION CODE MBK1.
10. In the Discharge Reason list, select the applicable discharge reason.
11. In the Type of Discharge list, select the type of discharge the member is taking. The default value is General.
12. The Home of Record is automatically populated.
13. In the Place From Ordered To ACDU box, type the Duty Station from which the member was ordered to active duty.
Pay Information
The Admin Preparer or Certifier must enter the information in this section. If a box is checked, the information for that option must be completed.
1. If applicable, check the Recoup Enlistment Bonus/Re-enlistment Bonus check box.
2. In the Authorization box, type the Authority that directed the enlistment bonus or reenlistment bonus recoupment entitlement, up to 50 characters.
3. If applicable, check the Lump Sum Leave check box.
4. From the Number of Days list, select the applicable Number of lump sum leave days. Valid values for this field are zero to 60, and is chargeable in five-tenths of a day increments in xx.x format. If applicable, updates to this field automatically reflect in the Number of Days field for Leave Awaiting Separation pay type. The default value for this field is 0.5.
5. The Previous LSL Used is not editable.
6. In the Authorization box, type the Authority that directed the lump sum leave entitlement, up to 50 characters
7. From the Leave Computation Balance list, choose the applicable Number of the balance of leave days.
8. In the Leave Computation As Of box, type the begin Date of the leave computation in YYYY/MM format.
9. From the Leave Computation Unreported Leave list, choose the applicable Number of unreported leave days leave. The Leave Computation Computed Leave Balance is automatically populated.
10. If applicable, check the Leave Awaiting Separation check box. To use this option, the required information must have been entered into the leave computation module that determines the member's correct leave balance.
11. From the Number of Days list, select the applicable Number of leave awaiting separation days. Valid values for this field are one to ninety in xx.x format. If applicable, updates to this field automatically reflect in the Number of Days field for Lump Sum Days pay type.
12. From the Permissive TAD Days, choose the applicable Number of permissive temporary active duty days.
13. The Departure Date box is automatically populated with the appropriate Date, in YYYY/MM/DD format, when the Number of Days leave to be taken is input.
14. In the Authorization box, type the Authority that directed the leave awaiting separation entitlement, up to 50 characters.
15. If applicable, check the Pay Separation Pay check box.
16. From the Active Service Years list, select the applicable Number of years of separation pay. Valid values are six to nineteen, and the default value is six.
17. From the Active Service Months list, select the applicable Number of months over the number of years of separation pay. Valid values are zero to eleven, and the default value is zero.
18. In the Authorization box, type the Authority that directed the separation pay entitlement, up to 50 characters.
19. If applicable, check the Pay Disability Severance Pay check box. The member must have completed six months of service to be eligible for this entitlement.
20. From the Active Service Years list, select the applicable Number of years of disability severance pay. Valid values are zero to nineteen, and the default value is zero.
21. From the Active Service Months list, select the applicable Number of months over the number of years of disability severance pay. Valid values are zero to eleven, and the default value is zero.
22. In the Authorization box, type the Authority that directed the disability severance pay, up to 50 characters.
23. If applicable, select the Loan Recoup check box.
24. In the Type list, select the applicable Type of loan.
25. In the Info box, type the Authority that directed the loan recoupment, up to 50 characters.
26. If you have information to add that is not applicable to the other categories, select the Other check box.
27. In the Description box, type a Description of the information and the Authority that directed the Other pay, in as many characters as necessary.
28. The following Accounting and Appropriation Data - Accounting Classification for Separation Without Orders information is automatically populated from the ODSE database.
· Appropriation Symbol and Subhead
· Object Class
· Bureau Control Number
· Sub Allotment
· Authorization Accounting Activity
· Transaction Type
· Property Accounting Activity
29. In the Cost Code(s) list, select the applicable code.
PART II - Marine Section
1. If applicable, check the Appellate Leave box. To use this entitlement, the required information must have been input into a leave computation module that determines the member's correct leave balance.
2. In the As of box, type the Effective Date of the appellate leave status, in YYYY/MM/DD format.
3. If applicable, select Voluntarily on Leave.
4. In the For Days box, type the 2-digit Number of days of voluntary appellate leave. Valid days are from zero to ninety, and the default value is zero.
5. If applicable, select Involuntarily on Leave.
6. In the For Days box, type the 2-digit Number of days of voluntary appellate leave. Valid days are from zero to ninety and the default value is zero.
7. If applicable, check the I Elect Payment Of box.
8. In the Days Lump-Sum Leave box, type the 2-digit Number of days to be paid for lump sum leave. The maximum number of days payable for lump sum leave is 60 days.
9. If applicable, check the I elect to be issued Government Transportation Request (s) box.
10. In the From box, the duty station is automatically populated from the ODSE database based on the member's RUC.
11. In the To box, type the Duty Station to which the member elected to be issued transportation requests.
12. If applicable, check the I elect to be paid advance separation travel allowances box.
13. In the From box, the duty station is automatically populated from the ODSE database based on the member's RUC.
14. In the To box, type the Duty Station to which the member elected to be issued transportation requests.
15. From the By list, select the Mode of Travel by which the member elected to travel to the new duty station. Auto is the default value.
16. In the Submit Claim To box, type the Complete Address of the disbursing office paying the advance.
17. In the Permanent Mailing Address box, type the member's Permanent Mailing Address, city and state, up to 100 characters.
18. In the EMail Address box, type the member's Email Address, up to 50 characters.
19. In the Contact Phone Number box, type the member's Emergency Contact phone number in (999)999-9999 format.
Diary Transaction Information
If anything is entered in this section, the Number field and the Date field are required to be entered by the Admin Preparer. It is not required by the Disbursing Preparer, but must be entered for the document to be certified.
1. In the Number box, type the five-digit diary Transaction Document Id number.
2. In the Date box, type the Diary Generated Date in YYYY/MM/DD format.
3. In the TTC box, type the three-digit TTC number.
4. In the SEQ box, type the three-digit TTC SEQ number.
5. In the Reported box, type the Description of the transaction up to 350 characters.
6. Choose Add Transaction. The Transaction is updated and displays beneath Add Transaction. A selected check box displays to the left of the transaction.
7. If you want to Delete a TTC Transaction, check the applicable Check Box. When the document is updated, the transaction no longer displays.
Other Options
1. Do one of the following:
· To Add a Document, choose Add Document. The document is added to the database.
· To Add a Document Comment to the document, choose Document Comment. The comment is attached to the current document.
· To Add or Forward the document to the Certifier to be reviewed, choose Add/Forward for Review. The document is added to the database and forwarded to the appropriate section.
2. You return to the User Console page.
See Also:
Create Document
Leave Computation
xe "Document:Duplicate Document"

xe "Duplicate Documents"Duplicate Document
You can create another document by copying one and changing the SSN and any desired fields.
How Do I Get Here?
1. Begin on the desired NAVMC 11116: Miscellaneous Military Pay Order/Special Payment Authorization page.
2. From the document options menu, select Duplicate Document. The Input SSN page displays.
3. In the Service Code and SSN box, type the member's one-digit Service Code and nine-digit Social Security Number. Choose Create. A document that has the same options and comments as the original document displays for the new social security number. 
4. Change the desired fields and then make another selection from the document options menu. 
xe "Document:Leave Computation"

xe "Leave Computation"Leave Computation
This function allows you to input leave information for a member to compute the Leave Computation Balance and then provides updated leave totals to the Lump-Sum Leave, Leave Awaiting Separation, and Appellate Leave totals, which are used in the processing of the documents.
See Also:
Create 11060 Document
xe "Add Document"

xe "Document:Add Document"Add Document
This function adds the newly created document to the Document Tracking and Management System database.
See Also:
Create 11060 Document
Create 11116 Document
Update Document
xe "Add Document Comments"

xe "Document:Document Comment"Document Comment
You can add a comment each time you forward a document. This comment floats with the document, and you are allowed to change its contents until the document is returned, certified, killed, or closed by a Certifier, at which time the comment becomes a permanent portion of the document.
To Add A Comment
1. Choose Add Document Comment. The document comment box displays.
2. In the Comment box, type your comment, up to 4000 characters, including spaces, returns and punctuation.
3. Do one of the following:
· To save your comment, choose OK. Your comment is attached to the document.
· To exit the page without typing a comment, choose Cancel.
4. You return to the Document page.
See Also:
Create 11060 Document
Create 11116 Document
Update Document
xe "Document:Update Document"

xe "Update Document"Update Document
This functionality allows you to open, change, and save information on a document that is on the Document Tracking and Management System database.
Any document that is created by the unit and has not been closed, killed, or deleted is considered to be an open document for that unit.
How Do I Get Here?
1. Begin on the User Console page.
2. On the Record you want to change, choose the member's Name. The Document page displays.
To Update a Document Page
Once a document is updated, and depending on the login ELSIG, the following options (to the left of the page) provide a variety of options to continue the processing of the document.
1. On the Document page, update the applicable fields.
2. From the document options menu, Do one of the following:
· To Update a Document, select Update Document button. The document is added to the database.
· To Add a Document Comment to the document, select Add Document Comment. The comment is attached to the current document.
· To Add or Forward the Document to be reviewed, select Update/Forward for Review. The document is added to the database and forwarded to the appropriate section.
· To Attach Another Document to this document, select Attachments. The Attach Files page displays, and the document is attached to the current document.
· To Close the document, select Close Document. 
· To Delete a document, select Delete Document. The document is deleted from the database.
· To Duplicate Documents, select Duplicate Document. The Input SSN page displays and a duplicate document can be created.
· To Kill the document, select Kill Document. 
· To Return the Document to the Preparer, select Return to Preparer. The document is returned to the Preparer.
· To Return the Document to Admin, select Return to Admin. The document is returned to Admin.
· To Send the Document to the Reviewer, select Forward to Reviewer. The document is forwarded to the Reviewer.
· To Send the Document to the Certifier, select Forward to Certifier. The document is forwarded to the Certifier.
· To Update and Forward to Disbursing, select Update/Forward to Disbursing. The document is updated and sent to Disbursing.
· To Update and Forward to NAMALA, select Update and Forward to NAMALA, the document is updated and sent to NAMALA.
· To View Attached Files, choose Attachments. The Attached Files page displays.
3. You return to the User Console page.
See Also:
Advisory Notice
Create An 11060 Document
Create An 11116 Document
Route Document
xe "Attach Correction"

xe "Document:Attach Correction"Attach Correction
This option is available only to Admin and only for a NAVMC 11060 that has been forwarded to Disbursing for review and returned to Admin for correction. 
The Admin Preparer or Admin Certifier must start the correction by adding the correction information. 
The Admin Reviewer can only review the information and forward it to the Admin Certifier or return it to the Admin Preparer. 
The Admin Certifier can make changes to the information, certify it, and forward it back to Disbursing for processing.
How Do I Get Here?
1. From the User Console page, choose the desired NAVMC 11060 document. The NAVMC 11060 page displays.
2. From the NAVMC 11060 page, choose Attach Correction. The NAVMC 11116 document displays.
To Include Correction Information
1. In the Instructions/Other box, type any correction information you want to include. 
2. Choose the applicable forwarding option. The document is updated and forwarded. You return to the User Console page.
xe "Document:Document History"

xe "Document History"Document History
This function allows you to view the events and status changes that occur to an electronic document during its life cycle and provides a link to the member's existing document.
Information is provided about the unit that created this document and the unit that it is currently assigned to. The date and time the document was last edited and the date the document was closed are also provided. The number of days the document has been in a working status, a list of the document history in the date and time order, with the newest time displayed first, are available. Displayed each time the document is processed are the Date and Time, the document action, the user's SSN and name, and if available, an attached comment.
The information for the document history is pulled from the Document Tracking and Management System Database, and the history statement list is sorted in descending order of date and time.  You may also attach a document from the history page, modify the document , and view any files attached to the document. If it was created by your unit, and you are a Disbursing or Admin Certifier level Authority ELSIG, or a Disbursing or Admin Preparer level Authority ELSIG, you can modify the document history.
How Do I Get Here?
1. Begin on the User Console page.
2. On the desired record, choose View History. The Document History page displays.
The following information displays:
Header
· User Name, of RUC or DSSN
· Title - Document History
Body
· Document ID
· Member Name
· Member SSN
· Originated By
· Currently Assigned To
· Last Updated
· Document Closed
· Hours Worked
At the Bottom
· Date
· Document Action
· By
· Comment
To Refresh the Document
To update the Document History page to the member's most current information, choose Refresh Report.
To Modify a Document From the Document History Page
Once you attach the document, depending on the login ELSIG and the status of the document, you can modify it.
· To modify a document, follow directions on the Update Document page, beginning in the How Do I Get Here? section, step 2.
To Print the Document
· On the record you want to print, choose Print Document. The document page displays.
See Also:
Create Document
Document Status
xe "Document:Route Document"

xe "Route Document"Route Document
There are two ways to route the NAVMC 11116 and the NAVMC 11060, Forward and Return.
You can Forward To:
· Admin Reviewer
· Admin Certifier
· Disbursing Preparer
· Disbursing Auditor
· Disbursing Certifier
· NAMALA (Available only for the NAVMC 11060 document)
You can Return To:
· Admin Preparer
· Disbursing Preparer
· Disbursing Auditor
xe "Return to Originating Admin"Return to Originating Admin
This option is available to the NAMALA Certifier. It is used to return the Appellate Leave document to the unit that created it.
How Do I Get Here?
· From the NAVMC 11060 document, choose Return to Originating Admin. The document is returned to the Admin pool of the office that created it.
See Also:
Route Document
xe "Delete Document"

xe "Document:Delete Document"Delete Document
This function allows you to delete a document from the Document Tracking and Management System database and returns you to the User Console. The document is no longer visible on any User Console.
To Delete A Document
1. From any document in the Document Tracking and Management System database, choose Delete Document. A message prompts you to confirm the deletion.
2. Do one of the following:
· To delete the document, choose OK. You return to the User Console.
· To cancel, choose Cancel. 
See Also:
Update Document
Advisory Notice
xe "Document:Kill Document"

xe "Kill Document"Kill Document
Once an Admin Certifier or Disbursing Certifier has certified a document, it cannot be deleted. If it is determined to be an invalid document, the document must be killed, a process that closes it and removes it from the database. A document can be killed only by the Admin Reviewer or Admin Certifier of the unit that generated it.
How Do I Get Here?
1. Begin on the User Console page.
2. On the Record you want to change, choose the member's Name. The Document page displays.
To Kill a Document
1. On the Document page, select the desired document.
2. Choose Kill Document. The document is killed.
See Also:
Update Document
xe "Close Document"

xe "Document:Close Document"Close Document
This function allows you to close the document when it has been completely processed and is no longer needed and if there is no further editing of the document necessary.
This option is only available for Disbursing Certifier-level Authority ELSIGs.
How Do I Get Here?
1. Once the document has been forwarded for a disbursing audit, start from the User Console. 
2. Choose the Member Name for the desired NAVMC 11116 form. The NAVMC 11116: Miscellaneous Military Pay Order/Special Payment Authorization page displays.
To Close the Document
· Choose Close. You return to the User Console.
See Also:
Update Document
xe "Attached Files"

xe "Document:Attached Files"Attached Files
This page allows you to view the files attached to the Miscellaneous Military Pay Order or Special Payment Authorization document or the Travel Pay Certificate document.
How Do I Get Here?
1. Begin on the Attach Files page.
2. Choose Attach File(s). The Attached Files page displays.
The following information displays:
Header
· Title - Attached Files
Body
· Attached Date
· User Unit
· User Name
· File Name
· Attached Time
· Description of Attachment
To View the Attached Files
· Choose the File you want to view. The File page displays.
To Close the Attached Files
· Choose Close. You return to the Document page.
See Also:
NAVMC 11060: Separation/Travel Pay Certificate
NAVMC 11116: Miscellaneous Military Pay Order/Special Payment Authorization
xe "Choose File"

xe "Document:Choose File"Choose File
This page allows you to search and select the file to upload or attach.
How Do I Get Here?
1. Begin on the ELSIG Upload page or the Attach Files page.
2. Choose Browse. The Choose File page displays.
To Choose a File
1. In the Look in box, select the desired drive and then the File you want to attach. The File displays in the File Name box.
2. Do one of the following:
· If you find the file you want to attach, choose Open. You return to the previous page.
· If you do not find the file you want to attach, choose Cancel. You return to the previous page.
See Also:
Attached Files
xe "Awaiting Zero Balance"

xe "Document:Awaiting Zero Balance"Awaiting Zero-Balance
This page lists NAVMC 11060 documents that have been certified by a disbursing unit and must be set to a balance of zero. Only Disbursing Preparer, Disbursing Certifier, and Disbursing Auditor-level authority ELSIGs have access to this page.
How Do I Get Here?
1. Begin on any Document Tracking and Management System page.
2. From the File menu, select Zero-Balance Documents. The Awaiting Zero-Balance page displays.
This page consists of the following information:
Header
· Title (NAVMC 11060 Documents Awaiting Zero-Balance)
Document Information
· Date Document Closed
· SSN
· Member Name
Footer
· Number of documents awaiting zero balance. 
To View the Document
· Choose the Member Name on the desired record. The Document page displays.
Note:If the document is an Advisory Notice, then zeroes display under SSN and Advisory Notice displays under Member Name.
To View the Document History
· Choose View History on the desired record. The Document History page displays.
To Print a Document Page
· On the record you want to print, choose Print Document. The Document page displays.
To Return Documents for Rework
1. Select the documents you want to return.
2. Choose Return for Rework. You return to the User Console page. The Return to Admin option is not available for these accounts.
To Forward for Zero-Balance Audit
1. If you are logged in as a disbursing auditor, select the documents you want to forward.
2. Choose Forward for Zero-Balance Audit. The documents are forwarded and you return to the User Console page. The selected accounts are no longer visible. 
To Forward for Zero-Balance Certification
1. If you are logged in as a disbursing reviewer, select the documents you want to forward.
2. Choose Forward for Zero-Balance Certification. The documents are forwarded and you return to the User Console page. The selected accounts are no longer visible. 
To Certify Zero-Balance
1. If you are logged in as a disbursing certifier, select the documents you want to certify.
2. Choose Certify Zero-Balance. The documents are certified and you return to the User Console page. The selected accounts have been routed to DSSN D0003.
To Close a Document
1. If you are working in the DSSN D0003 RUC, select the documents you want to certify.
2. Choose Close Document. You return to the Awaiting Zero Balance page. The selected accounts have a different Date Document Closed and have a status of zero-balance.
Note: This option is not available for accounts with an appellate leave status.
xe "Advisory Notice"

xe "Document:Advisory Notice"Advisory Notice
An advisory notice is created for a RUC, by the Disbursing Office (DO) to notify the Admin Office to start an action on member's records. It is added to the Document Tracking and Management System database and can be edited until it is forwarded for review. The Disbursing Preparer, Disbursing Auditor, and the Disbursing Certifier-level Authority ELSIGs have access to this function.
How Do I Get Here?
1. Begin on the any Document Tracking and Management System page.
2. From the File menu, select New Document and then choose Advisory Notice. The Advisory Notice page displays.
This page consists of the following information:
Header
· Title (Advisory Notice from DSSN: )
· RUC
To Create an Advisory
1. In the RUC box, type the applicable RUC.
2. In the Comments box, type the advisory notice.
3. From the document options menu, do one of the following:
· Select Add Document. The advisory is added to the database.
· Select Add/Forward for Review. The advisory is added to the database and is forwarded for review.
4. You return to the User Console page.
To View the Advisory Notice Document
1. To display the Advisory for a document, choose Advisory Notice under the Member Name column. The applicable Document displays.
2. Do one of the following:
· To Add a Comment to the document, select Document Comment. The comment is attached to the current document.
· To Delete a Document, select Delete Document.
· To Update a Document, select Update Document. 
· To Update or Forward the document to the Certifier to be reviewed, choose Update Document or Forward for Review/to Certifier. The document is added to the database and forwarded to the appropriate section.
To View the History
· To view the advisory history, choose View History on the desired advisory. The View History page displays.
To Print the Advisory
1. To print the advisory, from the browser File menu, choose Print. The Browser Print window opens.
2. Choose the desired Options.
3. Choose Print. The document prints.
4. You return to the previous page.
See Also:
Disbursing Auditor
Disbursing Certifier
Disbursing Preparer
View Attached Files
xe "Final Settlement Comment"Final Settlement Comment
This page allows the Disbursing ELSIG to add information for zero balance certification of a document. Only Disbursing Preparer, Disbursing Certifier, and Disbursing Auditor-level authority ELSIGs have access to this page.
How Do I Get Here?
· Begin on the Awaiting Zero Balance page. Choose Forward for Zero Balance Audit. The Final Settlement Comment page displays.
To Add a Final Settlement Comment
1. In the Final Settlement Comment box, type the desired information.
2. Do one of the following:
· If you want to forward the comment, choose OK. The comment is saved and forwarded with the document for processing.
· If you do not want to forward the comment, choose Cancel. The information is canceled and you return to the previous page.
See Also:
Route Document
xe "Document:View Attached Files"

xe "View Attached Files"View Attached Files
This page allows you to view all attached documents.
How Do I Get Here?
1. Begin on any NAVMC 11060 or NAVMC 11116 document.
2. Choose Attachments. The Files Currently Attached page displays.
To View Attached Files
1. Choose the Attachments option. The Files Currently Attached page displays.
2. Choose the Attached date or Attached By/File Name. The attached Document page displays.
3. Choose Close. You return to the Document page.
See Also:
Attach Files
Create 11060 Document
Create 11116 Document
xe "Document:Print Document"

xe "Print Document"Print Document
Any Document Tracking and Management System document or attached document can be printed from the document page.
How Do I Get Here?
1. Begin on the Document or Report you want to print a document from.
2. On the Record you want to print, choose Print Document. The document displays.
To Print a Document
1. From the browser File menu, choose Print.  The Browser Print window opens.
2. Choose the desired Options.
3. Choose Print. The document prints.
4. You return to the previous page.
See Also:
Create 11060 Document
Create 11116 Document
Create Document
Managing DTMS 

xe "Preferences"

xe "Section Maintenance"Section Maintenance
This function allows you to add or delete a section to the database or add or remove members in a section. A message informs you when the process completes successfully or if the process fails. You can self-assign yourself to a document to work on it or self-assign yourself to a section. Only Admin and Disbursing Certifier-level ELSIGs have access to this page.
How Do I Get Here?
1. Begin on any Document Tracking and Management System page.
2. From the Tools menu, choose Preferences. A sub Menu displays.
3. From the sub Menu, choose Section Maintenance. The Section Maintenance page displays.
This page displays the following information:
Header
· DSSN or RUC
· Title (Section Maintenance)
Body 
· New Section
· Allow Self Assignment
· Add Section
· Members for Section 
· Allow Self Assignment
· Available Members 
· Select All
· Selected Members
· Select All
To Add a Section to the Database
1. In the New Section box, type in upper case the Section name of the unit you want to add (up to 30 characters)
2. To enable yourself to work on documents in the new section, select Allow Self-Assignment. You are assigned to work the new section documents.
3. Choose Add Section. The New Section is added to the database.
4. To add members to the section, from the Members for Section list, select the desired section you want to choose members from.
5. To enable yourself to work on the documents in the new section, Select Allow Self-Assignment. You are assigned to work on the new section documents and the members from the chosen section display in the Available Members box.
6. In the Available Members box or the Selected Members box, select the Members you want to add or delete in the section.
7. Do one of the following:
· Choose the Greater Than or Less Than character. The selected members are added to or deleted from the section and display in the applicable member's box. 
OR
· Beneath the Available Members box or the Selected Members box, choose the applicable Select All button and then choose the Greater Than or Less Than character. The members are added to or deleted from the section and display in the applicable members box. 
8. To save your changes, choose Update Section and the section changes are updated. A message at the bottom of the page informs you if the update was successful.
To Delete a Section
1. In the Members for Section box, select the Section you want to delete. 
2. Choose Delete Section. A message prompts you to verify the deletion.
3. Choose OK. The Section is deleted from the database.
See Also:
User Defaults
xe "Preferences"

xe "User Defaults"User Defaults
This function allows you to choose the section you want to display on the User Console. You must be assigned to the section you choose for it to be available to you as a user default.
How Do I Get Here?
1. Begin on any Document Tracking and Management System page.
2. From the Tools menu, choose Preferences. A sub Menu displays.
3. From the sub Menu, choose User Defaults. The User Defaults page displays.
The following information displays:
Header
· User name of RUC or DSSN
· Title(User Defaults)
To Update the User Defaults
1. In the Default Section box, select one or more Section you want to be the default. 
2. To move one or more sections to either Available Sections or Assigned Sections, do one of the following:
· Choose the Less Than or Greater Than symbol.
· Choose Select All beneath the applicable Sections box.
3. Choose Apply Updates. The changes are saved.
4. A Message informs if you the update was successful or if it failed.
See Also:
Section Maintenance
Reports

xe "Create Report"Reports
Only a user within the unit that created the document and that has been assigned to that document, can modify it through the report. All other users have view only access. You can scroll to the top, previous, next and bottom to navigate through the records.
The available reports are:
· 5-Day EAS Report
· 10-Day Quad Report
· 10-Day Separation Report
· Appellate Leave Report
· Missing NAVMC 11060 Report
· Pending TTC's Report
· RFL Management Report
· Unit Statistics Report
See Also:
Print Document
Reports

xe "5 Day EAS Report"

xe "Reports"5-Day EAS Report
This report can be viewed online or printed and provides a list of separation documents (11060) that are within five days or less of the Expiration of Current Contract date on the form, excluding appellate leave documents.
From this report depending on your login ELSIG and depending on the status of the document, you can view any document listed, modify any document that was created by your unit, and view any files attached to a document listed. Once the document is in review or certifier status, it cannot be modified.
How Do I Get Here?
1. Begin on any Document Tracking and Management System page.
2. From the Menu, choose Reports. A sub Menu displays.
3. From the sub Menu, choose 5-Day EAS. The 5-Day EAS Report displays.
This report displays the following information:
Header
· User Name (First and MI, Last)
· DSSN or RUC
· Title (5-Day EAS Report)
Body
· First Certified Date
· SSN
· Member Name (Last, First, MI)
· View History
· Type
· Status
· Print Document
At the Bottom
· Top
· Previous
· Next
· Bottom
To View the Document History
· Choose View History. The Document History page displays. 
To Modify the Document Page
1. On the record you want to modify, choose the member's Name. The Document page displays.
2. Follow the directions on the Update Document help page, beginning with the To Update a Document Page section.
To View the Most Current Report Information
· Choose Refresh Report. The report page displays the most current information.
To Print the Report
· On the desired record, choose Print Document. The document displays. 
See Also:
Create Report
xe "10 Day Quad Report"

xe "Reports"10-Day Quad Report
This report can be viewed online or printed and provides a list of all electronic Quad6 documents that are still in an open status ten days after their initial certification.
From this report depending on your login ELSIG and depending on the status of the document, you can view any document listed, modify any document that was created by your unit, and view any files attached to a document listed.
How Do I Get Here?
1. Begin on any Document Tracking and Management System page.
2. From the Menu, choose Reports. A sub Menu displays.
3. From the sub Menu, choose 10-Day Quad. The 10-Day Quad Report displays.
This report displays the following information:
Header
· User Name (First and MI, Last)
· DSSN or RUC
· Title (10-Day Quad Report)
Body
· From Date
· To Date
· Refresh Report
· First Certified Date
· SSN
· Member Name (Last, First, MI)
· View History
· Type 
· Status
· Print Document
At the Bottom
· Top
· Previous
· Next
· Bottom
To View the Document History
· Choose View History. The Document History page displays. 
To View Information From Specific Dates
1. In the From Date box, type the beginning date you want information from. 
2. In the To Date box, type the ending date you want information to. The information for the period specified displays on the report.
To Modify the Document Page
1. On the record you want to modify, choose the member's Name. The Document page displays.
2. Follow the directions on the Update Document help page, beginning with the To Update a Document Page section.
To View the Most Current Report Information
· Choose Refresh Report. The report page displays the most current information.
To Print the Report
· On the desired record, choose Print Document. The document displays. 
See Also:
Create Report
xe "10 Day Separation Report"

xe "Reports"10-Day Separation Report
This report can be viewed online or printed and provides a list of all electronic separation documents (11060) in an open status that were originally certified with less than ten days prior to the Expiration of Current Contract date on the form, excluding appellate leave documents.
From this report depending on your login ELSIG and depending on the status of the document, you can view any document listed, modify any document that was created by your unit, and view any files attached to a document listed. Once the document is in review or certifier status, it cannot be modified.
How Do I Get Here?
1. Begin on any Document Tracking and Management System page.
2. From the Menu, choose Reports. A sub Menu displays.
3. From the sub Menu, choose 10-Day Separation. The  10-Day Separation Report displays.
This report displays the following information:
Header
· User Name (First and MI, Last)
· DSSN or RUC
· Title (10-Day Separation Report)
Body
· First Certified Date
· SSN
· Member Name (Last, First, MI)
· View History
· Type 
· Status
· Print Document
At the Bottom
· Top
· Previous
· Next
· Bottom
To View the Document History
· Choose View History. The Document History page displays. 
To Modify the Document Page
1. On the record you want to modify, choose the member's Name. The Document page displays.
2. Follow the directions on the Update Document help page, beginning with the To Update a Document Page section.
To View the Most Current Report Information
· Choose Refresh Report. The report page displays the most current information.
To Print the Report
· On the desired record, choose Print Document. The document displays. 
See Also:
Create Report
xe "Appellate Leave Report"

xe "Reports"Appellate Leave Report
This report can be viewed online or printed only by the Disbursing ELSIGs and provides a list of Appellate Leave Separation documents (11060) that are in an open status. This report displays all documents that have your RUC as the originating RUC. For all administrative units except Navy and Marine Corps Appellate Leave Activity (NAMALA), the query uses the Originating Unit ID column. For NAMALA, the query uses the Current Unit ID column.
From this report, depending on your login ELSIG and depending on the status of the document, you can view any document listed, modify any document that was created by your unit, and view any files attached to a document listed. Once the document is in review or certifier status, it cannot be modified.
How Do I Get Here?
1. Begin on any Document Tracking and Management System page.
2. From the Menu, choose Reports. A sub Menu displays.
3. From the sub Menu, choose Appellate Leave. The Appellate Leave Report displays.
This report displays the following information:
Header
· User Name (First and MI, Last)
· DSSN or RUC
· Title (Appellate Leave Report)
Body
· First Certified Date
· SSN
· Member Name (Last, First, MI)
· View History
· Type 
· Status
· Print Document
At the Bottom
· Top
· Previous
· Next
· Bottom
To View the Document History
· Choose View History. The Document History page displays. 
To Modify the Document Page
1. On the record you want to modify, choose the member's Name. The Document page displays.
2. Follow the directions on the Update Document help page, beginning with the To Update a Document Page section.
To View the Most Current Report Information
· Choose Refresh Report. The report page displays the most current information.
To Print the Report
· On the desired record, choose Print Document. The document displays. 
See Also:
Create Report
xe "Pending TTCs Report"

xe "Reports"Pending TTC Report
This report can be viewed online or printed. It provides a list of NAVMC 11116 documents that are ready to be reviewed or certified but do not have diary numbers for all TTC's listed for the document.
How Do I Get Here?
1. Begin on any Document Tracking and Management System page.
2. From the Menu, choose Reports. A sub Menu displays.
3. From the sub Menu, choose Pending TTC. The Pending TTC Report displays.
This report displays the following information:
Header
· User Name (First and MI, Last)
· DSSN ANNNN or RUC NNNNN
· Title (Pending TTC Report)
Body
· Original Certification Date
· SSN
· Member Name (Last, First, MI)
· View History
· Type
· Status
At the Bottom
· Top
· Previous
· Next
· Bottom
To View the Document History
· Choose View History. The Document History page displays. 
To Modify the Document Page
1. On the record you want to modify, choose the member's Name. The Document page displays.
2. Follow the directions on the Update Document help page, beginning with the To Update a Document Page section.
To View the Most Current Report Information
· Choose Refresh Report. The report page displays the most current information.
To Print the Report
· On the desired record, choose Print Document. The document displays. 
See Also:
Create Report
xe "Missing NAVMC 11060 Report"

xe "Reports"Missing NAVMC 11060 Report
This report is available to all ELSIG users and can be viewed online or printed. It provides RFL, HQMC the ability to identify and track individuals within a time range who separated from the Marine Corps and who do not have an active/recent NAVMC 11060 document within Document Tracking and Management System. Only Admin Preparers, Certifiers, ECOs, and Commanding Officers have access to create a new NAVMC 11060 for those individuals.
This report retrieves a large number of records from ODSE and takes some time to execute.
How Do I Get Here?
1. Begin on any Document Tracking and Management System page.
2. From the Menu, choose Reports. A sub Menu displays.
3. From the sub Menu, choose Missing NAVMC 11060. The Missing NAVMC 11060 Report displays.
This report displays the following information:
Header
· User Name (First and MI, Last)
· DSSN ANNNN or RUC NNNNN
· Title (Missing NAVMC 11060 Report)
Body
· SSN
· Member Name
· Grade
· ECC
· PRUC
· DSSN
To View Information From Specific Dates
1. In the From Date box, type the beginning date you want information from. 
2. In the To Date box, type the ending date you want information to. The information for the period specified displays on the report. The default value is 30 days from the current system date.
To View the Most Current Report Information
· Choose Refresh Report. The report page displays the most current information.
To Create the Missing 11060
· Choose Create 11060. The Input SSN page displays.
To View All Documents For an SSN
· On the desired record, choose Print Document. The document displays. 
See Also:
Create Report
xe "Reports"

xe "RFL Management Report"RFL Management Report
This report can be viewed online or printed and allows you to enter a date range for the report to cover. It provides a list of disbursing symbols that have documents that fall into the date range along with the averaged work times for each document type, as well as averages for the Marine Corps as a whole. When an individual disbursing symbol is selected, it provides a breakout of all RUCs that submitted documents to that symbol for the date range and average work times for each document type.
From this report depending on your login ELSIG and depending on the status of the document, you can view any document listed, modify any document that was created by your unit, and view any files attached to a document listed. Once the document is in review or certifier status, it cannot be modified.
How Do I Get Here?
1. Begin on any Document Tracking and Management System page.
2. From the Menu, choose Reports. A sub Menu displays.
3. From the sub Menu, choose RFL Management Report.
4. The Report displays.
This report displays the following information:
Header
· User Name (First and MI, Last)
· DSSN or RUC 
· Title (RFL Management Report)
Body
· From Date
· To Date
· Refresh Report
· Documents Worked by DSSN
· Average Hours Worked
· Documents Worked by RUC
· Average Hours Worked
· Documents Worked for SSN
· Average Hours Worked
· Member Name (Last, First, MI)
· Document Type
· Last Certified Date
· Hours Worked
· View History
· Document Status
· Print Document
To View the Document History
· Choose View History. The Document History page displays. 
To Modify the Document Page
1. On the record you want to modify, choose the member's Name. The Document page displays.
2. Follow the directions on the Update Document help page, beginning with the To Update a Document Page section.
To View Information From Specific Dates
1. In the From Date box, type the beginning date you want information from. 
2. In the To Date box, type the ending date you want information to. The information for the period specified displays on the report.
To View the Most Current Report Information
· Choose Refresh Report. The report page displays the most current information.
To Print the Report
· On the desired record, choose Print Document. The document displays. 
See Also:
Create Report
xe "Reports"

xe "Unit Statistics Report"Unit Statistics Report
This report can be viewed online or printed and provides the Admin Units visibility to activity on documents submitted to their Disbursing Unit, the current status for those documents, and the date they were closed.
How Do I Get Here?
1. Begin on any Document Tracking and Management System page.
2. From the Menu, choose Reports. A sub Menu displays.
3. From the sub Menu, choose Unit Statistics. The Unit Statistics Report displays.
This report displays the following information:
Header
· User Name (First and MI, Last)
· DSSN ANNNN or RUC NNNNN
· Title (Unit Statistics Report)
Body
· From Date
· To Date
· 10-Day Quad
· 10-Day Separation
· Pending TTCs
· RFL Management
· 5-Day EAS
· Appellate Leave
· Unit Statistics
· Missing NAVMC 11060
· Worked by RUC
· Advisory Notice (Open, Closed, Killed)
· NAVMAC 11060 (Open, Closed, Killed)
· NAVMAC 11116 (Open, Closed, Killed)
· During (Current Month/Year)
· Advisory Notice (Open, Closed, Killed)
· NAVMAC 11060 (Open, Closed, Killed)
· NAVMAC 11116 (Open, Closed, Killed)
· Documents worked for SSN
· Name (Last Name, First Name, MI or Advisory Notice)
· Type of Document
· Date Last Certified
· Status of Document
· During (Previous Month/Current Year)
To View Information From Specific Dates
1. In the From Date box, type the beginning date you want information from. 
2. In the To Date box, type the ending date you want information to. The information for the period specified displays on the report.
To View the Most Current Report Information
· Choose Refresh Report. The report page displays the most current information.
To View the Document History
· Choose View History on the desired record. The Document History page displays.
To Print a Document Page
· On the record you want to print, choose Print Document. The document displays.
See Also:
Create Report
NLOC

xe "What's New"What's New
SR2001.2
The following items were accomplished with this release:
System Change Requests (SCRs)
ITD113-00: Document Tracking and Management System (Document Tracking and Management System).
This SCR created a web-based document entry and tracking system used at DFAS, Kansas City.
TSO128-02: Additional Document Tracking and Management System Reports
This SCR added new reports Missing NAVMC 11060 Report and Unit Statistics Report. The reports were requested by RFL, HQMC or were identified as necessary for the successful implementation of Document Tracking and Management System by the SAT team while testing the application.
TSO130-02: Oracle DB Conversion
This SCR allowed the conversion of the database from MS SQL Server 2000 to Oracle, eliminating the need to purchase MS SQL Server 2000 and creating a savings in software costs.
TSO132-00: Paid Checkage Zero Balance
This SCR added the Awaiting Zero Balance topic which displays a critical report that provides the Disbursing Unit the ability to track and route normal (non-appellate leave) 11060's once they have been paid and are awaiting Zero-Balancing. It also enables them to approve or to rework the document.
See Also:
Narrative List of Changes
xe "Narrative List of Changes"Narrative List of Changes SR2001.2
See the What's New topic.
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